
Obiecte matematice:
Editorul de ecuaţii OpenOffice.org

Titlu: Obiecte matematice: Editorul de ecuaţii OpenOffice.org
Versiune: 2.0
Prima ediţie: Ianuarie 2005
Prima ediţie 
în engleză: Ianuarie 2005
Prima ediţie 
în română: Martie 2005





CIORN  - bazat  pe software nefinalizatĂ ă Cuprins

Cuprins

Privire de ansamblu...........................................................................................................................iii

Copyright şi mărci înregistrate.....................................................................................................iii

Părerea dumneavoastră.................................................................................................................iii

Mulţumiri.....................................................................................................................................iii

Modificări şi actualizări................................................................................................................iii

Introducere..........................................................................................................................................1

Să începem (Getting started)..........................................................................................................1

Introducerea unei formule...................................................................................................................2

Fereastra Selecţie...........................................................................................................................2

Exemplul 1:....................................................................................................................................3

Meniul contextual..........................................................................................................................4

Markup...........................................................................................................................................5

Caracterele greceşti........................................................................................................................5

Exemplul 2:....................................................................................................................................6

Personalizări (Customizations)...........................................................................................................7

Editorul de formule ca fereastră separată.......................................................................................7

Cum pot să măresc formula?..........................................................................................................8

Aspectul formulei...............................................................................................................................9

Folosiţi paranteze...........................................................................................................................9

Ecuaţii pe mai multe rânduri..........................................................................................................9

Întrebări frecvente.............................................................................................................................11

Cum adaug domenii pentru sumă/integrală?...............................................................................11

Parantezele pentru matrice arată oribil!.......................................................................................11

Cum scriu derivatele?..................................................................................................................12

Numerotarea ecuaţiilor.................................................................................................................12

Comenzile matematice - Referinţă...................................................................................................14

Operatori unari / binari.................................................................................................................14

Operatori relaţionali.....................................................................................................................15

Operaţiu cu mulţimi / şiruri ........................................................................................................16

Funcţii..........................................................................................................................................17

Obiecte matematice i



CIORN  - bazat  pe software nefinalizatĂ ă Cuprins

Operatori......................................................................................................................................18

Atribute........................................................................................................................................19

Diverse.........................................................................................................................................21

Paranteze......................................................................................................................................22

Formate........................................................................................................................................23

Caracterele greceşti......................................................................................................................24

Caractere speciale........................................................................................................................24

Obiecte matematice ii
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Privire de ansamblu

OpenOffice.org are  o componentă (OOo Math) pentru ecuaţii  matematice.   OOo Math vă 
crează obiecte matematice pe care le puteţi introduce în alte documente OOo, sau le puteţi 
păstra separat.

Copyright şi m rci înregistrateă
Conţinutul acestui document este protejat de Licenţa de Documentaţie Publică, versiunea 1.0 
(numită în continuare Licenţa); aveţi permisiunea de a folosi această documentaţie numai dacă 
sunteţi  de  acord  cu  prevederile  licenţei.  O  copie  a  licenţei  este  disponibilă  la  :
http://www.openoffice.org/licenses/PDL.rtf.

Documentaţia originală a fost scrisă în limba engleză şi este intitulată  Obiecte matematice: 
Editorul de ecuaţii OpenOffice.org. Autorul primei versiuni este Daniel Carrera © 2004. Toate 
drepturile rezervate. (îl puteţi contacta la  dcarrera@openoffice.org). Contactaţi autorul numai 
pentru a semnala erori în documentaţie.  Pentru întrebări  despre cum să folosiţi  programul, 
înscrieţi-vă pe lista de mail pentru utilizator şi scrieţi întrebările dumneavoastră acolo. Lista de 
mail o găsiţi la adresa http://support.openoffice.org/index.html.)

Traducerea în limba română a documentaţiei a fost realizată de Amăriuţei Gheorghe aka ghrt. 
Toate  drepturile  cuvenite  traducătorului  rezervate.  Pentru  eventualele  inadverdenţe  cu 
originalul în limba engleză sau cu programul îmi puteti trimite mail la ghrt@k.ro, sau pe lista 
de  discuţii  dev@ro.openoffice.org.  Vă  rog  să  specificaţi  în  subiectul  mesajului  "Obiecte 
matematice" sau "open office", deoarece primesc foarte mult spam.

Toate mărcile înregistrate aparţin utilizatorilor legitimi.

P rerea dumneavoastră ă
Dacă  doriţi  să  faceţi  comentarii  sau  sugestii  despre  acest  document  vă  rog  să  scrieţi  la 
authors@user-faq.openoffice.org. Pentru  versiunea  în  limba  română,  adresa  este 
dev@ro.openoffice.org.

Mul umiriţ
Acest capitol este scris pornind de la un document creat de Ian Laurenson pentru OOo v1.x.
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Modific ri şi actualiz riă ă

Versiune Data Descrierea modific riiă

1.0 24 Nov 2004 First published version.

2.0 24 Jan 2005 First published version for OOo 2.0

2 03/02/05 Tradus în limba română
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Introducere

OpenOffice.org  (OOo)  vă  oferă  o  componentă  pentru  scrierea  ecuaţiilor  matematice, 
OOoMath. Este folosită de obicei pentru editarea ecuaţiilor din documentele text, dar poate fi 
utilizată şi în cadrul altor aplicaţii sau în mod separat. Când este utilizată cadrul Writer-ului 
ecuaţiile sunt gestionate ca obiecte incluse în documentul text.

Notă Editorul de ecuaţii este utilizat doar pentru scrierea ecuaţiilor în forma specifică (după 
cum se vede în ecuaţia 1 de mai jos). Dacă doriţi să evaluaţi o expresie matematică vă 
rugăm să citiţi ghidul pentru Calc.

df  x
dx

=ln  xtan−1 x2  
(1)

S  începem (Getting started)ă
Pentru a  insera o ecuaţie,  mergeţi  la  Inserare  > Obiect  > Formulă  (Insert  > Object  > 
Formula).

Editorul de ecuaţii deschide o zonă în partea de jos a ecranului şi o fereastră separată apare pe 
ecran.  De  asemenea,  veţi  observa  şi  un  mic  dreptunghi  (cu  margini  gri)  în  documentul 
dumneavoastră; este locul unde formula va fi afişată.

Imaginea 1. Editorul de ecuaţii, fereastra Selecţie ("Selection"), şi locul unde se va afişa formula.

Obiecte matematice 1
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Editorul de ecuaţii foloseşte un limbaj de tip markup (este un cuvânt derivat dintr-o expresie 
tipografică) pentru a reprezenta formulele. De exemplu,  %beta reprezintă caracterul grecesc 
beta (  ). Acest limbaj este conceput să semene cu limba engleză cât mai mult posibil. De 

exemplu,  a over b (a supra b) reprezintă o fracţie: 
a
b

.

Introducerea unei formule

Sunt trei metode simple de a introduce o formulă:

• Selectaţi simbolul formulei din fereastra Selecţie ("Selection").

• Daţi clic - dreapta în editorul de ecuaţii şi selectaţi simbolul formulei din meniul apărut.

• Tastaţi "markup" în editorul de ecuaţii.

Meniul  şi fereastra Selecţie inserează markup-ul corespunzător simbolului  formulei.  Astfel, 
puteţi să învăţaţi mai uşor limbajul markup pentru OOoMath.

Notă Daţi clic pe textul documentului pentru a iesi din editorul de ecuaţii.
Daţi dublu - clic pe o formulă pentru a o edita.

Fereastra Selec ieţ
Cea mai simplă metodă pentru a introduce o formulă este fereastra Selecţie, arătată în Imaginea
2.

Imaginea 2. Simbolurile sunt împărţite în două categorii

Fereastra Selecţie este împărţită în două categorii principale.

• Partea de sus grupează categoriile de simboluri. Dati clic pe acestea pentru a schimba 
lista simbolurilor.

• Partea de jos arată lista simbolurilor disponibile în categoria curentă.

Obiecte matematice 2
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PONT Puteţi să afişaţi sau să ascundeţi fereastra Selecţie cu Vizualizare > Selecţie (View > 
Selection).

Exemplul 1: 5×4

Pentru acest exemplu vom introduce o formulă simplă: 5×4 cu ajutorul fereastrei Selecţie:

1) Selectaţi dintre categorii butonul grafic din stânga-sus (Imaginea 3).

2) Daţi clic pe simbolul înmulţirii (ca în Imaginea 3).

Imaginea 3. Operatori unari/binari

Când selectaţi simbolul înmulţirii în fereastra Selecţie se petrec două lucruri:

• Editorul de ecuaţii arată markup-ul: <?> times <?>

• În textul documentului apare un dreptunghi gri cu imaginea: ×

Imaginea 4. Simbolul pentru înmulţire

Simbolurile de genul “ <?> ” (Imaginea 4) sunt locurile în care veti scrie text. Ecuaţia va fi 
actualizata în mod automat, iar rezultatul va fi cel din Imaginea 5.

Obiecte matematice 3
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Imaginea 5. Rezultatul introducerii lui "5" şi "4" de o parte şi de alta a operatorului  
"times" ("înmulţire")

PONT Pentru  ca  ecuaţia  să  nu  mai  fie  actualizată  automat,  selectaţi  Vizualizare  > 
AutoActualizează ecranul (View >AutoUpdate display). 
Pentru  a  actualiza  manual  o  formulă,  apăsaţi  F9 sau  selectaţi  Vizualizare  > 
Actualizare (View > Update).

Meniul contextual
Altă metodă pentru accesarea simbolurilor matematice este să daţi clic - dreapta pe editorul de 
ecuaţii. Aceasta va conduce la apariţia unui meniu ca cel din Imaginea 6.

Imaginea 6. Meniul contextual.

Notă Opţiunile din acest meniu corespund exact cu cele arătate în fereastra Selecţie.

Obiecte matematice 4
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Markup
Puteţi introduce direct în editorul de ecuatii limbaj markup. De exemplu, dacă tastaţi “5 times 
4” obţineti 5×4 . Dacă veţi învăţa limbajul markup, aceasta va fi cea mai rapidă metodă de a 
introduce o formulă.

PONT Pentru a va reaminti mai uşor, reprezentarea formulei în limbajul markup aminteşte 
de cum sună citirea formulei în engleză.

Mai jos este o scurtă listă de ecuaţii des întâlnite şi reprezentările corespunzătoare.

Formula Comanda Formula Comanda

a=b a = b a sqrt {a}

a2 a^2 an a_n

∫ f x dx int f(x) dx ∑ an
sum a_n

a≤b a <= b ∞ infinity

a×b a times b x⋅y x cdot y

Caracterele greceşti

Caracterele  greceşti  (  , , , ,  etc)  sunt  des  întâlnite  în  formule  matematice.  Aceste 
caractere nu se găsesc în fereastra Selecţie sau în meniul contextual. Astfel încât va trebui să 
învăţaţi reprezentarea lor textuală, care din fericire este destul de simplă: Tastaţi semnul % 
urmat de numele literei pe care o doriţi, dar în engleză.

• Pentru a introduce o minusculă, scrieţi numele caracterului cu minuscule.

• Pentru a introduce o majusculă, scrieţi numele caracterului cu minuscule.

Iată şi câteva exemple:

Minuscule Majuscule

%alpha   %ALPHA  A

%beta   %BETA  B

%gamma   %GAMMA  

%psi    %PSI   

%phi    %PHI   

%theta   %THETA  

Notă Tabelul cu toate caracterele alfabetului grecesc este inclus în pagina 25.

Obiecte matematice 5
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Altă modalitate de a insera caractere greceşti este de a folosi fereastra Catalog. Alegeţi Unelte 
> Catalog  (Tools  > Catalog).  Fereastra  catalog este  arătată în  Imaginea 7.  Sub Setul  de 
simboluri  (“Symbol  Set”)  selectaţi  "Grecesc"  (“Greek”)  şi  daţi  dublu  -  clic  pe  o  literă 
grecească din listă.

Imaginea 7. Catalog - utilizată pentru introducerea caracterelor greceşti.

Exemplul 2:  ≃ 3.14159

Pentru acest exemplu vom presupune că:

• Vrem să introducem formula de mai sus (valoarea lui PI rotunjită la 5 zecimale).

• Ştim numele caracterului grecesc (“pi”).

• Dar nu ştim cuvântul din limbajul markup pentru simbolul ≃ .

Pasul 1: Tastaţi “%” urmat de textul “pi”. Va apare simbolul  .

Pasul 2: Deschideţi fereastra Selecţie (Vizualizare > Selecţie "View > Selection").

Pasul 3: Simbolul ≃  denotă o relaţie, aşa că vom apăsa pe butonul grafic pentru relaţii . 
Dacă ţineti mausul deasupra acestui buton (şi aveţi ponturile activate) va apare indicaţia despre 
categoria butonului, "Relaţii" “Relations” (Imaginea 8).

Imaginea 8. Pontul indică butonul grafic "Relaţii" ("Relations").

Obiecte matematice 6
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Pasul 4: Ştergeţi textul <?> şi adăugaţi “3.14159” la sfârşitul ecuaţiei.  Aici vedem în fereastra 
editorului de ecuaţii “ %pi simeq 3.14159 ”, ca în Imaginea 9.

Imaginea 9. Rezultatul final

Personaliz ri (Customizations)ă

Editorul de formule ca fereastr  separată ă
După cum se vede în  Imaginea 1, editorul de formule poate acoperi o parte semnificativă a 
ferestrei  de  editare  a  Writer-ului.  Pentru  a  transforma editorul  de  formule  într-o fereastră 
separată procedaţi astfel:

1) Ţineţi mausul deasupra marginii ferestrei editorului de formule, ca în Imaginea 10.

2) Ţineti apăsată tasta Control şi daţi dublu - clic.

Imaginea  10.  Ţineti  apăsată  tasta  Control şi  daţi  dublu  -  clic  pe  marginea  
editorului de formule matematice pentru a-l transforma într-o fereastră separată.

Imaginea 11 arată rezultatul. Puteţi (re)doca fereastra folisnd aceiaşi paşi. Ţineţi apăsată tasta 
Control şi daţi dublu - clic  key deasupra marginii ferestrei.

Obiecte matematice 7



CIORN  - bazat  pe software nefinalizatĂ ă Personaliz ri (Customizations)ă

Imaginea 11. Editorul de ecuaţii în fereastră separată.

Cum pot s  ă m rescă  formula?

Aceasta  face  parte  dintre  întrebările  cele  mai  des  repetate  de  către  utilizatorii  OOoMath. 
Răspunsul este simplu, dar nu intuitiv:

1) Porniţi editorul de formule şi alegeţi Fonturi > Mărimea fontului (Fonts > Font size).

Imaginea 12. Schimbarea  mărimii fontului a unei formule

2) Selectaţi o mărime de font mai mare de la "Mărimea de bază" (“Base Size”) (câmpul cel 
mai de sus), ca în Imaginea 13.

Obiecte matematice 8
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Imaginea 13. Editaţi "Base size" (sus) pentru a mări formula.

Resultatul este arătat în Imaginea 14.

Imaginea 14. Resultatul schimbării mărimii fontului de bază.

Aspectul formulei

Cea mai dificilă parte a utilizării OOoMath vine atunci când scrieţi ecuaţii complicate. Această 
secţiune vă oferă câteva sfaturi despre scrierea formulelor complexe.

Folosi i parantezeţ
OOoMath nu "ştie" nimic despre ordinea operaţiilor (vă reamintesc că OOoMath este pentru a 
reprezenta formule,  nu pentru  a le  calcula!).  Trebuie  să folosiţi  paranteze pentru a stabili 
explicit ordinea operaţiilor. De exemplu:

Expresie markup Rezultat

2 over  x + 1 2
x
1

2 over {x + 1} 2
x1

Ecua ii pe mai multe rânduriţ

Să presupunem ca doriţi să tastaţi o ecuaţie scrisă pe mai multe rânduri. De exemplu:
x=3
y=1

Obiecte matematice 9
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Prima dumneavoastra reacţie ar fi să apăsaţi pur şi simplu Enter. Totuşi, veţi observa că atunci 
când apăsaţi  Enter expresia markup trece pe linia următoare, însă nu şi ecuaţia. Va trebui să 
tastaţi explicit comanda pentru o linie nouă. Aceasta este arătată în tabelul de mai jos (newline 
se traduce prin linie nouă).

Expresie markup Rezultat

x = 3

y = 1
x=3 y=1

x = 3 newline

y = 1
x=3
y=1

Obiecte matematice 10



CIORN  - bazat  pe software nefinalizatĂ ă Întreb ri frecventeă

Întreb ri frecventeă

Cum adaug domenii pentru sum /integral ?ă ă
Comenzilor “sum” and “int” li se pot specifica (opţional) parametrii “from” şi “to”. Acesţia 
sunt utilizaţi pentru începutul şi sfârşitul domeniului. Aceşti parametri pot fi folosiţi câte unul 
sau împreună.

Expresie markup Rezultat

sum from k = 1 to n a_k
∑
k=1

n

ak

int from 0 to x f(t) dt

∫
0

x

f  t dt

int from Re f ∫
ℜ

f

sum to infinity 2^{-n} ∑
∞

2−n

Notă Pentru mai multe detalii despre integrale şi sume, citiţi tabelul de la pagina 18.

Parantezele pentru matrice arat  oribil!ă
Pentru început, să vedem sintaxa comenzii pentru matrici:

Expresie markup Rezultat

matrix { a # b ## c # d } a b
c d

Notă Rândurile sunt separate de două caractere # şi conţinutul fiecărui element este separat 
printr-un singur #.

Prima problemă este că parantezele obişnuite nu "acoperă" toată matricea:

Expresie markup Rezultat

(  matrix { a # b ## c # d }  ) 
a b
c d



OOoMath oferă paranteze "scalabile". Aceasta înseamnă că aceste paranteze cresc o data cu 
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conţinutul matricei. Folosiţi comenzile  left( and right) (stânga şi dreapta) pentru a introduce 
paranteze scalabile.

Expresie markup Rezultat

left(  matrix { a # b ## c # d }  right) a b
c d 

PONT Folosiţi left[ şi right] pentru paranteze scalabile pătrate.

Cum scriu derivatele?
Scrierea derivatelor se face folosind un truc: Le scrieţi ca pe o fracţie.

Cu alte  cuvinte,  va trebui  să folosiţi  comanda “over”.  Combinaţi  aceasta fie  cu litera  “d” 
(pentru o derivare integrală) sau comanda “partial” (pentru o derivare parţială) pentru a obţine 
aspectul unei derivate.

Expresie markup Rezultat

{df} over {dx} df
dx

{partial f} over {partial y} ∂ f
∂ y

{partial^2 f} over {partial t^2} ∂2 f

∂t 2

Notă Observaţi că a trebuit să folosim acolade pentru a scrie derivata.

Numerotarea ecua iilorţ
Numerotarea ecuaţiilor este una dintre facilităţile obscure ale OOoMath. Paşii de urmat sunt 
simpli, dar neintuitivi:

1) Treceţi pe o linie nouă.

2) Tastaţi “fn” şi apoi apăsaţi F3.

Cuvântul “fn” este înlocuit de o formulă numerotată:

E=mc2  (2)

Acum puteţi da dublu - clic pe formulă pentru a o edita. De exemplu, mai jos este funcţia 
Riemann Zeta:

 z =∑
n=1

∞ 1

nz
 (3)

Obiecte matematice 12
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Puteţi să faceţi o referire la o ecuaţie (“după cum puteţi oberva în ecuaţia (2)”) urmând aceşti 
paşi:

1) Inserare > Referinţă (Insert > Cross-reference).

2) Daţi clic pe categoria Referinţe (References tab) (Imaginea 15).

3) Sub Tip (Type), selectaţi Text.

4) Sub Selecţie (Selection), alegeţi numărul ecuaţiei.

5) Sub Format, alegeţi Referinţă (Reference).

6) Apăsaţi Inserează (Insert).

Gata! Dacă mai târziu veţi adăuga ecuaţii în document înaintea ecuaţiei referite, toate ecuaţiile 
vor fi în mod automat renumerotate iar referinţele actualizate, astfel încât să indice ecuaţiile 
iniţiale.

Imaginea 15. Inserarea unei referinţe către o ecuaţie numerotată.

PONT Pentru a insera numărul ecuaţiei fără paranteze, alegeţi Numerotare (Numbering) sub 
Format în loc de Referinţă (Reference).

Obiecte matematice 13
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Comenzile matematice - Referinţă

Operatori unari / binari

Opera iaţ Comanda Se afişează

semnul + +1 1

semnul – –1 −1

semnul +/– +–1 ±1

semnul –/+ –+1 ∓1

Operatorul logic NON neg a ¬a

Adunarea + a + b ab

Înmulţirea (punct) a cdot b a⋅b
Produs cartezian (X) a times b a×b

Înmulţirea (*) a * b a∗b

Operatorul logic ŞI a and b a∧b

Scăderea (–) a – b a−b

Împărţirea (fracţie) a over b a
b

Împărţirea (operator) a div b a÷b

Împărţirea (bară) a / b a /b

Operatorul logic SAU a or b a∨b

Compunere a circ b a°b
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Operatori rela ionaliţ

Opera iaţ Comanda Se afişează

Este egal a = b a=b

Diferit a <> b a≠b

Aproximativ a approx 2 a≈2

Divide a divides b a∣b

Nu divide a ndivides b a∤b

Mai mic a < 2 a2

Mai mare a > 2 a2

Izomorf a simeq b a≃b

Paralel a parallel b a∥b

Perpendicular a ortho b a⊥b

Mai mic sau egal a leslant b ab

Mai mare sau egal  a geslant b ab

Asemenea a sim b a~b

Congruent a equiv b a≡b

Mai mic sau egal a <= b a≤b

Mai mare sau egal a >= b a≥b

Proporţional a prop b a∝b

Tinde a toward b ab

Implicaţie  inversă  sau 
reciproca

a dlarrow b a⇐b

Echivalent a dlrarrow b a⇔b

Implicaţie  directă 
(rezultă)

a drarrow b a⇒b
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Opera ii cu mul imi / şiruri ţ ţ

Opera iaţ Comanda Se afişează

Aparţine a in B a∈B

Nu aparţine a notin B a∉B

Conţine A owns b A∋b

Mulţimea vidă emptyset ∅

Intersecţia A intersection B A∩B

Reuniunea A union B A∪B

Diferenţă A setminus B A ∖B

Mulţimea cât (factor) sau 
factorizarea lui A cu B

A slash B A/B

Alef aleph ℵ

Inclus A subset B A⊂B

Inclus sau egal A subseteq B A⊆B

Include  A supset B A⊃B

Include sau egal A supseteq B A⊇B

Nu este inclus A nsubset B A⊄B

Nu este inclus sau egal A nsubseteq B A⊈B

Nu include A nsupset B A⊅B

Nu include sau egal A nsupseteq B A⊉B

Mulţimea nr. naturale setN ℕ

Mulţimea nr. întregi setZ ℤ

Mulţimea nr. rationale setQ ℚ

Mulţimea nr. reale setR ℝ

Mulţimea nr. complexe setC ℂ
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Func iiţ

Opera iaţ Comanda Se afişează

Exponenţial func e^{a} ea

Logaritm natural ln(a) ln a

Funcţia exponent exp(a) expa

Logaritm log(a) log a

Putere a^{b} ab

Sinus sin(a) sin a
Cosinus cos(a) cosa

Tangentă tan(a) tan a
Cotangentă cot(a) cot a

Radical (ord. 2) sqrt{a} a

Arcsinus arcsin(a) arcsin a

Arccosinus arccos(a) arccos a
Arctangentă arctan(a) arctan a

Arccotangentă arccot(a) arccot a
Radical (ord. nth ) nroot{a}{b} ab

Sinus hiperbolic sinh(a) sinh a

Cosinus hiperbolic cosh(a) cosh a

Tangentă hiperbolică tanh(a) tanh a

Cotangentă hiperbolică coth(a) coth a

Valoare  absolută  sau 
modul

abs{a} ∣a∣

Arcsinus hiperbolic arsinh(a) arsinh a

Arccosinus hiperbolic arccosh(a) arcosh a

Arctangentă hiperbolică arctanh(a) artanh a

Arccotangentă 
hiperbolică

arccoth(a) arcoth a

Factorial fact(a) a!
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Operatori
Toţi operatorii pot fi folosiţi pe domenii (cu “from” şi “to”).

Opera iaţ Comanda Se afişează

Limită lim(a) lim a

Suma sum(a) ∑ a

Produs prod(a) ∏ a

Coprodus coprod(a) ∐ a

Integrală definită int from {r_0} to {r_t} a
∫
r 0

r t

a

Integrală int{a} ∫a

Integrală dublă iint{a} ∬a

Integrală triplă iiint{a} ∭ a

Sumă de la sum from{3}b ∑
3

b

Integrală  pe  o  curbă 
închisă

lint a ∮a

Integrala  dublă  pe  o 
suprafaţă închisă

llint a ∯a

Integrală  triplă  pe  un 
domeniu  mărginit  de  o 
suprafaţă închisă

lllint a ∰a

Produs până la prod  to{3} r
∏

3

r
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Atribute
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Opera ieţ Comanda Se afişează

Accent  ascuţit acute a a
Accent grav grave a a

Reverse circumflex check a a
Breve breve a a

Cerculeţ circle a å

Săgeată de vector vec a a

Tildă tilde a a
Circumflex hat a a

Linie deasupra bar a a
Punct dot a ȧ

Săgeată de vector lată widevec abc abc

Tildă lată widetilde abc abc

Circumflex lat widehat abc abc

Punct dublu ddot a ä

Linie deasupra overline abc abc

Linie dedesupt underline abc abc

Tăiat cu o linie overstrike abc acb

Puncte puncte dddot a a

Spaţiu transparent (dacă doriţi 
să lăsaţi spaţiu)

phantom a

Font îngroşat bold a a

Font italic1 ital “a” a

Stabiliţi mărimea fontului size 16 qv qv
Font "sans serif"2 font sans qv qv

Font "serif" font serif qv qv

Font de dimensiune fixă font fixed qv qv

Colorează textul ce urmează 
cu bleu3

color cyan qv qv

1 Textul în afara ghilimelelor care nu este o comandă va fi considerat a fi o variabilă. Variabile sunt în mod obişnuit 
scrise cu font italic.

2 Sunt trei  tipuri  de fonturi proprii:  sans serif  (simple), serifs, şi  fixe (ne-scalabile).  Pentru a schimba fonturile 
utilizate pentru variabile, numere şi funcţii alegeţi Formatare > Fonturi (Format > Fonts).

3 Când coloraţi textul, culoarea se va aplica numai textului care urmează imediat după comandă, până ce este întâlnit 
următorul spaţiu. Pentru a aplica culoarea la mai multe caractere (cuvinte), închideţi textul de colorat în acolade.
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Opera ieţ Comanda Se afişează

Colorează textul ce urmează 
cu galben

color yellow qv qv

Colorează textul ce urmează 
cu verde

color white qv qv

Colorează textul ce urmează 
cu alb

color green qv qv

Colorează textul ce urmează 
cu albastru

color blue qv qv

Colorează textul ce urmează 
cu roşu

color red qv qv

De la verde din nou la negru color green X qv X qv

Folosiţi acoladele pentru a 
colora mai mult text

color green {X qv} X qv
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Diverse

Opera ieţ Comanda Se afişează

Infinit infinity ∞
Derivată parţială partial ∂
Nabla nabla ∇
Există exists ∃
Oricare forall ∀
H hbar a ℏ a

Lambda lambdabar ƛ

Partea reală re ℜ

Partea imaginară im ℑ

Weierstrss p wp ℘

Săgeată stânga leftarrow 
Săgeată dreapta rightarrow 
Săgeată sus uparrow 
Săgeată jos downarrow 
Puncte jos dotslow 
Puncte la mijloc dotsaxis ⋯
Puncte verticale dotsvert ⋮
Puncte diagonale urcând dotsup ⋰
Puncte diagonale coborând dotsdown ⋱
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Paranteze

Opera ieţ Comanda Se afişează

Paranteze rotunde (a) a

Paranteze pătrate [b] [b]

Paranteze duble pătrate ldbracket c rdbracket 〚c〛
Linii lline a rline ∣a∣

Linii duble ldline a rdline ∥a∥

Acolade lbrace w rbrace {w}

Paranteze unghiulare langle d rangle 〈d 〉

Paranteze unghiulare langle a mline b rangle 〈a∣b〉

Paranteze  de  grupare 
(sunt  interpretate  de 
program)

{a} a

Paranteze  rotunde 
scalabile
(adăugati  cuvintele  left  -  
stânga pentru  paranteza 
stângă şi  right  -  dreapta 
pentru cea dreaptă)

left ( stack{a # b # z} right ) abz 
Paranteze  pătrate 
scalabile (vezi mai sus)

left [ stack{ x # y} right ] [ xy ]
Paranteze  pătrate 
scalabile duble

left  ldbracket  c  right 
rdbracket 

〚c〛

Linie scalabilă left lline a right rline ∣a∣
Linie dublă scalabilă left ldline d right rdline ∥d∥
Acoladă scalabile left lbrace e right rbrace {e }
Paranteze  unghiulare 
scalabile

left langle f right rangle 〈 f 〉

Operator  brackets 
scalable

left  langle  g  mline  h  right 
rangle 

〈 g∣h 〉

Acolade  deasupra 
scalabile

{The  brace  is  above} 
overbrace a The brace is above

a

Acolade  dedesupt 
scalabile

{the  brace  is 
below}underbrace {f}

the brace is below
f
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Formate

Opera ieţ Comanda Se afişează

Indice superior stânga a lsup{b} ab

Indice superior a csup{b}
a
b

Indice superior dreapta a^{b} ab

Subsol inferior stânga a lsub{b} ab

Subsol inferior a csub{b} a
b

Subsol inferior dreapta a_{b} ab

Aliniază caracterul la stânga 
(textul este în mod obişnuit 
centrat) 

stack { Hello world # alignl (a) } Hello world
a

Centrează caracterul stack{Hello world # alignc(a)} Hello world
a

Aliniază  caracterul  la 
dreapta

stack { Hello world # alignr(a)} Hello world
a

Combinări binom{a}{b} a
b

Suprapunere, mai mult de  2 stack{a # b # z} a
b
z

Matrice matrix{a # b ## c # d} a b
c d

Aranjament  matematic 
obişnuit

matrix{a # "="b ## {} # "="c} a = b
= c

Linie nouă asldkfjo newline sadkfj asldkfjo
sadkfj

Spaţiu mic - Apostrof stuff `stuff stuff stuff

Spaţiu mare - tildă stuff~stuff stuff stuff
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Caracterele greceşti

%ALPHA A %BETA B %CHI X %DELTA  %EPSILON E

%ETA H %GAMMA  %IOTA I %KAPPA K %LAMBDA 

%MU M %NU N %OMEGA  %OMICRO
N

O %PHI 

%PI  %PSI  %RHO P%SIGMA  %THETA 

%UPSILO
N  %XI  %ZETA Z

%alpha  %beta  %chi  %delta  %epsilon 

%eta  %gamma  %iota  %kappa  %lambda 

%mu  %nu  %omega  %omicron  %phi 

%pi  %rho  %sigma  %tau  %theta 

%upsilon  %varepsilo
n 

 %varphi  %varpi  %varrho ϱ

%varsigma  %vartheta  %xi  %zeta 

Caractere speciale

%and ∧ %angle ∢ %element ∈ %identical ≡

%infinite ∞ %noelement ∉ %notequal ≠ %or ∨

%perthousand  %strictlygreaterthan ≫ %strictlylessthan ≪ %tendto 
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